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What is Linux, why is it free?

Linux is a free open source computer operating system first created by Linus Torvalds in 1991. It is
licensed under the General Public License (GPL). This license allows Linux to be modified, copied
or redistributed by anyone in a completely “free” way. Thousands of volunteer developers around
the world work on Linux improvements and contribute new applications.

GPL software is known as “open­source” this means the source code is publicly available to share
with others.  In contrast, proprietary software such as Microsoft Windows is “closed­source”, the
code is not readily available and it is illegal to copy and share the software.

Software   useful   for   families,   students   and   concession   holders   has   been   included   on   the
Computerbank computer. Enjoy!

Using free Linux software enables Computerbank to keep the costs of our computers low.
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Setting Up Your Computerbank Computer
It's easy to panic when you arrive home with your new computer, many people feel like this. Follow 
these simple steps to set up your computer and you will be computing in no time. Check the index on 
page 3 to find the answer any other question you may have.

Plugging in your computer
1. Plug the mouse into a USB socket at the back of the computer
2. Plug the keyboard into a USB socket at the back of the computer

The USB Slots at the front of your computer are handy to plug in USB devices for 
convenience

3. Connect your monitor (screen) to your computer. 
You will have either a DVI monitor connection or a VGA Monitor Connection. (see below)

         OR 

4. Plug in the power cord for the screen
5. Plug in the power cord for the computer

Turning on your computer and monitor. It will take less than 60 seconds for the operating system to 
load. The Computerbank system loads automatically without logging in. There is currently no easy way 
to change the system so that a password is needed to log in.

Turning off your computer
To turn off your computer safely, Click on the Power Button located at the top Right Hand side of the 
screen, then Click on “Shutdown” and your computer will turn off.
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Internet Connections
Cable, ADSL or NBN connection: Plugging in a Network Ethernet Cable
If you have a wired network Internet connection, plug in your network cable.
(Ethernet cables that come with modems are usually yellow. Other ethernet
cables are usually blue). The network manager icon will animate for a time. 
A message about being connected to a wired network will be displayed. Your
computer should now connect to the Internet. 
If this is not successful, try clicking the network manager icon and disconnect, then connect again. If this
is not successful, you may need to configure the modem. 
ADSL modems are usually configured using a web browser. Follow the instructions provided with your 
modem. You will need the username and password the ISP gave you (not the username and password 
for your computer).

USB Modems – Broadband (ADSL or Cable – not mobile broadband) 
Broadband modems with USB connections generally do not work with Linux. You need to use a 
broadband modem with an Ethernet connection. 

WiFi connection
If your computer is capable of WiFi (most laptops are, but
few desktops) click on the Network Manager icon to show
the list of available WiFi networks.
If you do not see a list of WiFi networks, make sure that
there is a tick in the “Enable Wi-Fi” entry in the list and
that WiFI is on. Some laptops have a switch to turn WiFi
on, others use a key combination.
Find your WiFi network in the list. (If it is not displayed,
move the mouse over “More networks”. You may need to
scroll the list.)
Click on the network name. You will be asked to enter the
access password – you only need to do this the first time.
After a short wait, you should see a “Connected”
message.
NOTE: If you click on ‘Cancel’, a connection will be
created without a password. Appendix 2 (Page 21) details
the method of fixing this.
If you don't have a wireless adaptor, call Computerbank
to ask what brand to get. Computerbank usually has
wireless cards and USB WiFi adapters available at low
cost. 

Mobile broadband modems
There are a number of different types of Mobile Broadband modems. The easiest to use are those that 
connect with WiFi. It is only necessary to power the modem and use Network Manager to select the 
correct WiFi name, then enter the password.
Other Mobile Broadband Modems connect in one of two ways. Most require the use of Network 
Manager to configure the connection. This only needs to be done the first time the modem is plugged in.
The details are in Appendix 1 part A (Page 19). This appendix also details how to use the modem to 
send and receive SMS messages.
Some modems will connect automatically as though they are a wired connection. These will give a 
message like ‘You are now connected to wired connection 2’. These do not require configuration. 
Appendix 1 part B (page 20) gives details on sending and receiving SMS messages and how to 
reconfigure the modem if it loses its settings.
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Checking mobile broadband usage
All mobile broadband service providers have an online facility to check account usage. Check with your 
provider. Note: the data may be up to 48 hours behind your usage.

You can also check the amount of data you are sending and receiving with “Modem­Manager­GUI” (see 
Appendix 1, Part A: page 19) or the Modem’s web interface (Appendix 1, Part B: page 20)

Using your Smart Phone's Data for your computer's Internet Connection
If you have an appropriate smart phone with a good amount (at least 1GB) of data allowance, you can 
connect your phone to your computer using a USB cable. On the phone, go to Settings and turn on your
USB Tethering. The phone should connect as a Wired Connection. 

You may also be able to use your phone as a WiFi hotspot. This will need to be configured. 
WiFi security should be set to WPA2 PSK.

Accessing Email
Computerbank recommends using free webmail services such as Gmail (mail.google.com) or Yahoo 
(au.mail.yahoo.com). The advantage of web mail is you can log in on any computer with internet access.

Adding A Printer
Not all printers work under Linux. To be safe choose a Hewlett Packard (HP) printer. Please call us 
before you buy a printer to make sure that it is compatible with Linux. If you buy a brand other than 
HP, you will need to bring the computer and the printer to Computerbank for driver installation. 
Computerbank cannot provide support for all printers, they all work differently. 

Setting up a Printer
Connect the printer to a USB connector at the back of your computer, put paper in, then turn the printer 
on. Wait a while as some printers will automatically set up. If successful, a box will appear confirming the
printer details.  A test page can also be printed.  

Manual set up can be attempted if automatic set up does not occur (see below). 
Additional information for HP printers is provided below. 

Manual Printer Setup
To set up your printer click on System > Administration > Printing 

In the Printers Utility (at left)
1. Click on Add
2. The utility will search for any connected printers.
3. Select your printer from the choices and click the forward button.
4. Describe your printer and click Apply. Accepting the suggestions 
is OK.

5. Finally, when prompted, print a test page to see if the setup 
worked.

HP Printers
HP printers can be managed using the HP Device Manager: it can often also be used to check 
ink levels and to align and clean cartridges.
Click the Applications menu > Accessories > HP Device Manager. 
Note: If your HP printer is not already installed (using the method above), a dialog box will advise it 
could not find any configured devices. Click on Set up new device. Answer a few questions to set up the 
printer. During setup a test page can be printed. 
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Managing Your Content
The File Manager area stores the files you create.  Linux system files have slightly different names 
compared to Windows and Mac.  For example in Windows your files would be in My Documents. In 
Linux your files are kept in a user’s home folder or directory.  In the screenshot below, the person 
logged in is called user. (user is the login name we gave you).  On the right side of the screen are the 
folders in user’s home directory.

To open the file manager 

At the top of your screen click on the Places Menu, and select Home Folder.

To see your files Double click on the folders to view contents. 

Organising your files
The files on the computer are very similar to a filing cabinet. The system files exist within a fixed 
structure. Over time, you will gather many files in your Home folder. To help with the management of 
these files, folders can be created inside the Home folder to store related items together.  The picture 
above shows the standard set of folders in the Computerbank system.

Creating a new folder
Click on your Home folder (see above).  Right click your mouse in the file
manager screen. Select Create Folder OR in the top menu of the file manager
click  File  > Create Folder and change the name to what you want.

Manage files by dragging and dropping or using cut and paste. Choose options from the right click 
mouse menu, or from the menu and icon toolbar.
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Backing up your data
It's crucial you keep copies of your important content. In any computer a hardware or software 
failure may occur. Making a copy of your information saves angst and anger. Backup your work by
copying important files to a USB drive or DVD disc. Keep this data separate from your computer.

Comparison:  Linux and Microsoft Windows File Storage
Location on Microsoft Windows Location on Linux

My Documents ~/Documents

My Pictures ~/Pictures

CD, DVD or USB storage
D:\ usually, but can be any drive letter to Z

/media/user/“name of device”

‘~’ means “/home/user”. user is the name of the person logged in. 

NOTE: Actual location and even the name may be different on different versions of Windows."

Using DVDs and USB devices
Place removable media gently into your computer's drive or USB slot.  An icon
will appear on the desktop and in the file manager. The Places Menu located in
the top panel on your desktop will have an extra item under the Computer
section and the file manager will have a new Devices section with the device
name added. 

Storage media can be safely removed in a number of ways. Close down file manager windows and any 
documents using removable media before unmounting or ejecting. Failing to do this may result in an 
error about a “busy” device. A CD/DVD will not eject if busy. 

In the file manager, in the Devices section, click the Eject button beside the device you want to 
remove.

You can right click the appropriate icon on the desktop or from within the file manager. Select Unmount 
or Eject. For CD and DVD media, pressing the eject button on the device can also work. 

Wait a few moments before removing USB media (If there is an activity indicator, wait for it to stop 
flashing.)

Copying a File or Folder to a USB Memory Stick
The easiest way to copy is by dragging and dropping from one folder to another. 

The Edit menu can also be used to copy a folder: 
1. Insert the memory stick into a USB port
2. When the file manager opens, change to the folder that contains the files/folders you want to copy
3. Select the files/folders to copy
4. Click the Edit  menu
5. Select Copy
6. From the left pane select the appropriate folder from Places and move to the destination folder
7. Go to the Edit menu again
8. Select Paste to place the file on the removable media. 
9. Before removing the memory stick, Eject or Unmount it.
Keyboard shortcuts like Ctrl+C (copy) and Ctrl+V (paste) can also be used. Files can be accessed by 
double clicking them to open. Files can be dragged and dropped between folders.

Note: Multiple selections can be made by clicking on one file/folder to select it, then holding the Ctrl key 
and clicking the other files/folders you want.
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Listening to an Audio CD
Listen to audio with Rhythmbox Music Player. It is found in Applications > Sound & Video > Rhythmbox 
Music Player. It will start automatically when an audio CD is inserted but music playing does not start 
automatically. Click the play button. 

MP3, wav, ram, or ogg recordings are played using Rhythmbox Music Player or VLC Media Player 
located under Sound & Video in the Applications Menu. 

Note: You need speakers or headphones to hear to audio recordings or DVD movies. Laptops have 
built­in speakers, but they do not produce good sound. Some desktops have built­in speakers but they 
are not stereo and usually poor sound quality.

To close Rhythmbox Music Player, you must click Close in the File menu or click the “Cog” icon on the 
right hand side and choose Quit. Clicking the X closes the window with Rhythmbox Music Player still 
playing. To stop it playing, you have to reopen it and click File>Close.

Watching a DVD Movie
Put a DVD movie disc gently into the drive.  The DVD will start playing automatically.

To watch full screen, press F on the keyboard, double click the movie or click on the Video Menu and 
then select Full Screen. To get back to the regular view, press F, ESC or right click and select 'Full 
Screen' again. 

Explore the other menus to find out what else VLC can do. 

Safely Closing Down and Ejecting a Disk
Close down VLC by selecting File > Exit or click the x in the window title bar. The disk can be safely 
ejected by pressing the button on the DVD player.  You can also right click the DVD icon on the desktop 
and select “Eject”. 

Burning CDs or DVDs
Burn CD's and DVD's with K3b: found in Applications menu > Sound & Video > K3b CD and DVD 
Burning.

Will my Scanner or Camera work with Ubuntu Linux?
Cameras – Most digital cameras are supported under Linux. They usually look like USB storage 
devices. If not, the storage card can be removed and used in a card reader to access the data.

Scanners – Many stand­alone scanners are not supported under Linux. Scanners that are part of 
supported printers usually are supported. Simple Scan will work with most supported scanners.  For 
compatible scanners see: http://www.sane­project.org/sane­supported­devices.html

Word Processing with LibreOffice
LibreOffice is similar to Microsoft Office. Importantly it can read and save in the Microsoft file formats. 
This means files you create with LibreOffice can be used on Windows or Apple computers that have 
Microsoft Office. LibreOffice has its own file format and you can also save your documents as PDFs if 
you wish. The Computerbank system saves in Microsoft formats for compatibility with other systems.

Libre Office is used by millions of people around the world for:
• word processing
• spreadsheets
• slide presentations
• drawing
• database
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Comparison of LibreOffice and Microsoft Office File Types

LibreOffice Microsoft Office Libre Office file types Microsoft file types

Write Word odt doc, docx

Calc Excel ods xls, xlsx

Impress Powerpoint odp ppt, pps, pptx, ppsx

Base Access odb Not file compatible

Draw No equivalent odg No equivalent

Math Equation odf Can’t save as file
LibreOffice can read, edit and save the Microsoft Office file types listed.

Open LibreOffice word processing by clicking on the page icon in the top menu on your desktop. (See 
picture below). That is the quickest way to open LibreOffice Writer.  Alternatively you go to  Applications 
in the top menu. Scroll down the menu and click on Office, move down the Office menu and click on 
LibreOffice Writer. 

Note: LibreOffice cannot read Microsoft Access databases, unless they have been converted to
other supported formats including ODBC, MySQL, dBase, text (csv), and spreadsheets. More
info at http://www.libreoffice.org

There is a very useful Help system for LibreOffice (see below)
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Two ways to open Libreoffice Writer

Or you can choose
Writer or any LibreOffice

 app from this menu

To Open LibreOffice Writer
Click here on the page icon

http://www.libreoffice.org/


Keyboard shortcuts for Linux
Keyboard shortcuts are a quick way to use your computer. Many Linux shortcuts are similar to shortcuts in other 
software. Keyboard shortcuts are listed next to menu items in some applications.

Some keyboard shortcuts:

[Ctrl]+[C] Copy

[Ctrl]+[X] Cut

[Ctrl]+[V]                Paste

[Ctrl] + [ALT] + [+]   Zooms in on the desktop

[Ctrl] + [ALT] + [­]   Zooms out on the desktop

[ALT] + [TAB]             Cycles through open applications

[ALT] + [F1]                ` Brings up the main menu

[ALT] + [F2]                Brings up the run dialog box

[ALT] + [F4]                Closes a window

[Ctrl] + [ALT] + [DEL]    Brings up the shutdown dialog box

Applications on your Computerbank Computer

Go to the Applications menu in the Top Left of your screen
The following list shows the software in the order you will find it in the menu.

Accessories
Archive Manager: Software to handle archives like zip, tar, bzip, rar and more
Calculator: A calculator
Character Map: Shows characters in a font and can copy them to the clipboard
Font Viewer: View fonts on the computer.
HP Device Manager: Manage HP printers
Search for Files: Utility for locating files
Take Screenshot: Take a screenshot of the desktop or a window
Terminal: Access the command line
Text Editor: Editor for plain text files

Education
Educational suite GCompris: Educational games for ages 2 to 10
Libre Office Math: Program for formatting mathematical equations
Tux Paint: Drawing program for children

Graphics
Blender: 3D modelling, animation
GIMP Image Editor: An advanced graphics program similar to Photoshop
Image Viewer: Simple image viewer
LibreOffice Draw: Image Editing and object drawing tool for office type work
MyPaint: Painting program for digital artists
Shotwell: Photo Manager and simple editor
Simple Scan: Used with scanners to scan images and documents
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Games
AisleRiot Patience: Many patience games
Chess: Play chess against the computer or another person
Defendguin: Save the penguins
Educational suite GCompris: Educational games for ages 2 to 10
Galaga: “Shoot­em­up” game from the 80s
Galaga:Hyperspace: Enhanced Galaga
Mahjongg: Tile matching game
Mines: Classic minesweeper game
Sudoku: Test your logic skills. Number grid puzzle
Supertux 2: 2D Platform game
Tetravex: Tile matching puzzle
Xboard: Play chess against the computer

Internet
Firefox Web Browser:  Firefox web browser
Gnome PPP: Configure and connect a dial up internet connection
Google Chrome: Google web browser, supports PLAY store
Modem­Manager­GUI Adds SMS and monitoring capability to USB Broadband Modems
Skype: Free Voice and Video over IP chat program
Transmission: BitTorrent client
Xchat: Internet Relay Chat

Office
Adobe Reader 9: Reads PDF files
GnuCash Finance: For managing budgets
Gramps Genealogy: Genealogy system. Create a family tree
LibreOffice Base: Database application
LibreOffice Calc: For spreadsheets similar to Microsoft Excel
LibreOffice Draw: Drawing application
LibreOffice Impress: For presentations similar to Microsoft Powerpoint
LibreOffice Math: Program for formatting mathematical equations
LibreOffice Writer: Word processing similar to Microsoft Word
MATE Document Viewer: PDF, epub, DejaVu and other file viewer
Online Dictionary:  Look up words, requires internet connection

Sound & Video
Audacity: For editing and recording sound
Cheese Webcam Save photos and videos from a web camera
K3b CD and DVD Burning CD and DVD Burning
Kino DV Editor: Edit digital videos
Linux Multimedia Studio: Create music
Rhythmbox Music Player: Play MP3s, CD's and other audio files. Internet radio
VLC Media Player: Multimedia player
Volume Control: Control your sound mixer
WinFF: Convert audio and video files between formats

System Tools 
Clam AV Virus Checker: Virus and Malware Scanner
Gdebi Package Installer: Install Ubuntu software packages
Log File Viewer: View system logs
MATE Disk Usage Analyser: Display information about hard drive space use
MATE System Monitor: Monitor and stop system processes
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Places
The file manager is started from the Places menu
Home Folder: The main folder for all of your personal data on the computer
Desktop: Access anything on the desktop
Documents: Office documents
Pictures, Music, Videos: For those file types
Downloads: Default folder for Internet downloads
Computer: Access other places on the computer
Network: Access any network folders
Connect to Server… Set up a connection to a network computer
Search for Files Search for files on the computer
Recent Documents  > Shows recently accessed documents 

System 
Administrative tasks are started from the System menu 

Preferences
About Me: Change your password
Appearance: Change the look and feel of your desktop
Assistive Technologies: Enable support for assistive technologies
Bluetooth Manager: Setup bluetooth (if available)
Displays: Set your primary monitor
File Management: Change settings related to file management
Keyboard: Set your keyboard preferences
Keyboard Shortcuts: Assign shortcut keys to commands
Mouse: Change properties for the mouse
Network Connections: Manage and change your network settings
Power Management: Manage Computer and Display power
Screensaver: Configure a screen saver
Volume Control: Volume Control
Windows: Set your window properties

Administration
Clam AV Virus Checker: Virus and Malware Scanner
Printers: Configure and manage printers
Software Updater: Checks for system updates
Ubuntu Software Centre: Install and remove software
Users and Groups: Add users, turn off automatic login

Other Items in the System menu
Help Help with the system
About MATE Brief description of the system
Lock Screen Lock your screen so no one can access your work
Log out user... Log out of your session so another user can login
Shut Down... Shut down the computer (another way to turn off)
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Customising your Computer
Here are some of the options for your desktop:

● Change font sizes to make the desktop easier to read
● Change your desktop background, theme and screen saver
● Add your own desktop backgrounds
● Languages (needs appropriate languages installed)
● Change mouse properties ­ left/right handed mouse
● Change keyboard options

To customise:

1. Click on the System menu. (See Picture 1) 
2. Go to Preferences and choose > Appearance.  (See Picture below)
3. Click over different items to see what options are available. 

To change your mouse from right handed to left handed operation: 
Click on the System Menu > Preferences  > Mouse and follow the onscreen instructions. 
If you are using a laptop, check the “Touchpad” tab.

Creating Shortcuts
You can create shortcut icons on your desktop to link to programs used regularly. Drag the program 
name from the main menu and drop it on the desktop. Menu items can also be dragged and dropped on 
to the panel at the bottom or top of your screen if there is enough free space. 

Inputting a Language other than English
Keyboard languages can be changed from System > Preferences > Keyboard, Layouts tab.

Screensaver
The screensaver is changed from System > Preferences > Screensaver.
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Frequently Asked Questions and How To's
Does Linux get computer viruses?
Linux is not currently threatened by many viruses unlike the Microsoft system which is plagued by 
viruses.  Computerbank’s Ubuntu operating system comes with a built­in firewall and virus protection 
software, Ubuntu is one of the most secure operating systems around.

Changing the user password
Click on System Menu > Preferences > About Me and click the 'change password' button. Your current 
password will be required. You will be required to confirm your new password. Your new password will 
need to be 6 characters or more.

Adding another user account
To add another user, follow these steps: 

1. Click on System Menu > Administration > Users and Groups
2. Click on “+Add”
3. Enter your password in the Password field.
4. Fill in the details requested by the form: Name and Username, click OK.
5. Set the password for the user: click OK.
6. You can add another user or click close

User names work better in lowercase. 

Disabling automatic login
Call Computerbank if you want to do this. You must be willing to use the commandline.
NOTE: There is currently no easy way to disable autologin.

Checking how much space I have on the hard drive
Hard drive space can be checked using the MATE System Monitor.  See picture below. Click on  
Applications > System Tools > MATE System Monitor. Check the File Systems tab. 

In the picture above /dev/sda2 is the hard drive and /dev/sdb1 is a USB memory key.

Activating the network card (for broadband)
Just plug an ethernet cable in! How easy. The Network Manager panel icon will animate for a time. A 
message about being connected to a wired network will be displayed. 

If this was not successful, try clicking the network icon in the panel next to the clock and select Edit 
Connections. Choose the appropriate connection to configure and enter details where requested. 
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Using Skype
We provide the Linux version of Skype software. This is similar to other versions of Skype and has 
support for some web cameras. 

To start Skype go to Applications > Internet > Skype. You need to agree to the license terms before 
being able to set up your account. Sound and video settings can be checked via the Options menu. You 
need to be logged in to a Skype account to access the Options menu.

Updating, Installing and Deleting software
An internet connection is required to update or install software.

Updating
If you see a message that Firefox or Chrome is out-of-date, use the Software Updater to update.

Go to the menu System > Administration  > Software Updater. (Example below.)

There will ususally be more items in 
the list.

You must have internet access to 
update softtware.

To just update Firefox and/or 
Chrome, remove the ticks from the 
headings, then tick the boxes against
Firefox and/or Chrome.

The amount to be downloaded will be
shown at bottom left of the window.

Click ‘Install Now”. You will be asked for an authorisation password. This is your user password.
The Software Updater can be used to update all the software, but may need a large download.

Removing or adding software
Software can be added, updated or removed with the Ubuntu Software Centre.
The Ubuntu Software Centre is in the menu System > Administration > Ubuntu Software Centre. 
You will be prompted to enter your password when you click the Install or Remove buttons.

CAUTION: Do NOT remove software you are unsure about. Always check you are not removing other 
programs by updating. 

Further information can be found using the Help option and by doing a web search. Include the term 
‘Linux’ and/or ‘Ubuntu’ when looking for information.  

NOTE: Messages may be displayed while installing or updating software.
Information messages can usually be ignored: press ‘Q’ to close the message.

Messages that ask if you want to update to a new version of a file should be answered with ‘N’ (no).
If this is the default, you can just press ‘Enter’.

Example:

Configuration file 'filename' 
 ==> Modified (by you or by a script) since installation. 
 ==> Package distributor has shipped an updated version. 
   What would you like to do about it ?  Your options are: 
    Y or I  : install the package maintainer's version 
    N or O  : keep your currently-installed version 
      D     : show the differences between the versions 
      Z     : start a shell to examine the situation 
 The default action is to keep your current version. 
*** filename (Y/I/N/O/D/Z) [default=N] ? 
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Troubleshooting Common Problems

Frozen or misbehaving programs or an unresponsive computer
Occasionally programs will freeze or start to behave strangely. If this happens you can end the program.
At the top of your screen click on Applications > System Tools > MATE System Monitor and click on 
Processes.  This will bring up a list of programs (processes) running on the system. Click on the 
program you wish to end.   

If nothing works, shutdown the computer by holding the power button for 10 seconds.

Dialog window takes over screen and can't be closed
If you can not access the minimise, maximise or close button in a program or a dialog window the 
keyboard and mouse can be used to move the window. While holding the ALT key with left click, use 
your mouse to drag the window into a better position. 
Or you can press the Ctl Alt F7 keys together: you can then move the window with the mouse or cursor 
keys.

Lost top Panel or Task Bar
1. Right click over an empty space on the remaining panel. 
2. Click on New Panel.

A new empty panel will appear. To add items back, right click the panel and choose Add to Panel. Menu
Bar is the main menu. 

Lost main menu
If you lose your main menu you can get it back by doing the following: 

1. Right click an empty space on the top panel and select “Add to Panel...”
2. When a dialog box appears search for “Menu bar”  or locate “Menu bar” from the list
3. Drag the 'custom menu bar' item to the panel or double click to place it on the panel
4. Right click the menu bar again and select “Lock to Panel” to lock it in place

Tip: If the menu does not go where you want it, right click the menu and select 'Move' to place it 
somewhere else. An item must be unlocked to move it. 

Can't Access the Desktop Menu Bar
If a program has taken over the whole screen and Esc won't return you to the desktop, Press the Ctl Alt 
F7 keys together. You can then move the window with the mouse or cursor keys.
Pressing Alt F4 keys together should close the program but you may lose unsaved work.

Printer not working
Check that the printer is turned on, that it has paper, that its cables are plugged in fully, and check if it is 
out of ink. If the ink is out, buy a replacement cartridge or refill. 

If the printer has stopped it will have a cross over it and will need to be refreshed once the problem has 
been rectified. At the top of the screen click on System scroll down to Administration > Printing. In many 
cases the printer will resume printing by itself.

Stopping the printer
Print jobs can be stopped by clicking on Applications > Accessories > Manage Print Jobs.  Print jobs can
be deleted by using the appropriate option from the Job menu or by right clicking over an entry.
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Can't read/open USB memory sticks
 The device may be faulty, unformatted or have been removed without closing correctly.  If you do not 
need the data that was on the device, you can reformat it: call Computerbank for help with this task. 

I can't connect to broadband internet
There are many reasons why this could be the case. 

• Check that all the cables are plugged in and going to the right places.
• Check that there is power to the modem and it is switched on. A red light on the modem usually 

indicates a problem.
• Is another computer using the same connection? If you take the cable out of the first computer 

and put it into another computer, the modem (or router) may need to be turned off and on at the 
wall (power cycled) for it to work.

• Check the configuration for the modem or router. This is accessed using a web browser (Firefox)
and an IP address (eg: 192.168.1.1 or 10.1.1.1). You may need the manual for the device. 

Boot stops at a text screen
There will be a message like “Give root password for maintenance (or type control-D to continue)”
Call Computerbank to book User Support. You will need to bring the computer to Computerbank for 
diagnosis and repair.

Kernel Panic message
These are rare. Kernel panic messages usually occur when starting or booting up your computer.  Call 
or email Computerbank: you will probably need to bring the computer to Computerbank for repair.

18



Appendix 1 – Mobile Broadband Internet
A. Using Network Manager to connect to the Internet.
Initial setup.
Connect the mobile broadband device to the computer and wait for approximately 30­40 seconds for the
computer to recognise the device as a modem. You may see the message :

1. Click the Network Manager icon in the top right hand side of the top panel. If your device has 
been successfully detected an option to configure it will be available. 

2. Select New Mobile Broadband Connection and a wizard should appear. Select the correct 
information for your account. Bigpond requires a user name and password, while other systems 
(including Telstra) do not. When successful, a message similar to that below will appear.

3. If your connection does not work despite it being available call Computerbank for advice. It is 
probably a settings issue. 

On subsequent occasions, after the ‘registered’ message appears, click on the Network Manager icon 
and select the network [Supplier] [Network name].

When you have finished using the internet, click on the Modem Manager icon and choose Disconnect 
before removing the modem.

Sending and receiving SMS messages

Phone companies send SMS messages when you reach 50%, 85% and 100% of your Data Allowance. 
“Modem Manager GUI” can be used to receive these messages and can also be used to send SMS 
messages.

“Modem Manager GUI” is started from the 
Internet menu. It should be started after the 
“You are now registered …” message has 
been displayed.

The Traffic tab will show the amount of data 
that has been sent and received during the 
current session. 

The “Statistics” can show data used each 
calendar month.

When you have finished using the Internet, 
click on the Modem Manager icon and select
“Disconnect” before removing the device.
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You are now registered on the home network.

Connection established
You are now connected to [Supplier] [Network name].

Modem Manager GUI



B. Modem connects as wired connection.
Some Mobile Broadband Modems (supplied by Vodafone) connect as a wired connection. These will 
display the message:

You will now be connected to the Internet.
These devices can be configured with a web browser. 
Sending and receiving SMS messages
Put 192.168.1.1 as the web address and the browser will connect to the modem’s web interface. Use 
the “SMS” tab to send and receive messages.
A window at the right side of the screen shows connection information including data used (“Total 
Volume”).
When you have finished using the Internet, you can just remove the device. You should see:

If you can’t connect to the internet, check the configuration: Settings tab, Connection item. The picture at
right shows the correct settings.

Sending and receiving SMS
messages

Put 192.168.1.1 as the web address and
the browser will connect to the modem’s
web interface. Use the “SMS” tab to send
and receive messages.

An area at the right side of the screen
shows connection information including
data used (“Total Volume”).
See picture below.
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Connection established
You are now connected to ‘wired
connection 2’.

Disconnected
Ethernet network.



Appendix 2 – Network Manager
Editing Network Manager settings
Click on the Network Manager icon and choose Edit Connections…

To delete an unwanted connection, click on it then click “�Delete”.

To change a WiFi connection’s password, click on it then click “�Edit”
Clicking on the “Wi-Fi Security” tab will allow you to change the password.

When finished, click “Save”.
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Computerbank's Ubuntu Desktop

Click to access
Web Browser

Click to start a new
Word Document

Click on Apps or Programs 
you opened on the bottom

Panel/Taskbar

Click here to setup 
your Internet Access

Click on Applications
Scroll Down to find programs

 on your computer
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